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Over v iew 
This guide is designed to provide you with step-by-step instructions on how to create, implement, and 
use forms. How you use forms depends on your role. This guide contains the following sections:  

• “Overview” introduces the forms feature to the ImageNow owner, managers, and ImageNow and 
WebNow Client users. 

• “Basic Procedures for ImageNow or WebNow” explains basic procedures such as how to search for a 
form and complete information in form fields. This information is of interest primarily to users with 
privileges to view, modify, create, or delete forms. 

• “ImageNow Form Designer” defines the high-level steps to implement forms and explains how to 
use Form Designer to create, save, and publish forms. This information is of interest primarily to the 
owner and managers. 

• “Administering Forms” explains some basic administration procedures and provides a high-level 
view of the administration process including assigning privileges and deploying forms. This 
information is of interest primarily to the owner and managers. 

• “Advanced Form Functionality for Developers” describes in technical terms how to enhance existing 
forms. This information is of interest primarily to owners or managers familiar with scripting. 

More specialized topics on working with forms are provided on the Perceptive Software website, in the 
Customer Portal, under Product Documentation. 

What is a form? 

In ImageNow, a form is a set of fields that contain information entered by a user. Depending on your 
system configuration, each field can be mapped to a custom property, making each field searchable in 
the system. 
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To complete a form, a user enters data into the fields of the form. Form data might also be pre-
populated by other ImageNow components.  If you purchased the Document Management license of 
ImageNow, you can add your documents, including forms, to version control.  

Form types 

Depending on your system configuration, you may be using the following types of forms: 
• A form displayed as a stand-alone document or on a folder. Depending on your system 

configuration, each field can be mapped to a corresponding custom property. After you fill in the 
fields and save the form, the system can automatically complete the values for the corresponding 
custom properties on ImageNow Server, allowing you to search for forms just as you would search 
for documents. You can publish the following types of stand-alone forms: 

• Stand-alone forms as documents. When you open a document, this form appears 
independently of a document in ImageNow Viewer. 

• Stand-alone forms on folders. You can select this form as the folder type when you create a 
folder. The form appears independently of a document in the ImageNow Folder Viewer. 

• A form displayed as supplemental information for a document or folder. This type of form allows 
you to capture additional data for your documents or folders. You can use supplemental forms in 
the following ways: 

• Supplemental forms for documents. When viewing a document in the ImageNow Viewer, these 
forms appear in the Forms pane. You can select from the available forms and fill out the fields to 
provide additional information about a document. 
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• Supplemental forms for folders. When viewing a folder in the ImageNow Folder Viewer, these 
forms appear in the Forms pane. You can select from the available forms and fill out the fields to 
provide additional information about a folder. 

What is ImageNow Forms Server? 

Use the ImageNow Forms Server and Forms Viewer applet to make a form available online using an 
embedded URL. You can only embed form types that are standalone on folders or documents. The user 
clicks the URL to access the form, enters information in the fields, and then saves the form. The system 
sends the saved form to ImageNow and WebNow as a document or on a folder. 

The following examples show how you might use forms in your portal or business application. 

(Higher Education) Students submit forms online to Admissions. The school intranet is secure. Students 
who are graduating this year must submit a form to apply for graduation. They use the URL that contains 
a pointer to the Forms Viewer applet, which integrates the applet into the intranet. After a student fills 
out the form, it is sent to a workflow queue in ImageNow that is accessible by the Registrar's office. This 
example shows where you might need a form to display as a document by associating it with a 
document type. 

(Human Resources) Employees working remotely can fill out the form for their flexible spending 
accounts. Each employee fills out the form online and itemizes the expenses. After the employee 
submits the form online, the system responds with a submission number. The employee then faxes the 
receipts using the submission number so that the receipts can be matched to the form later. To receive 
and import the receipts into ImageNow, the company uses ImageNow Fax Agent.  This example shows 
where you might need a form to display on a folder. 

For more information on Forms Server, refer to the ImageNow eForms Forms Server Installation and 
Setup Guide available on the Customer Portal. 

Form ro les 

Users assume one of the following roles in forms: 

• Manager (or owner). An ImageNow manager grants and denies privileges to view, create, modify, or 
delete forms. A manager can create custom properties in Management Console that make fields 
available to choose from when creating a form in Form Designer. A manager can also create and 
view all saved form designs in Form Designer. The manager can publish forms to the ImageNow and 
WebNow clients. If Forms Server is installed, the manager may choose to publish forms online using 
an embedded URL. For simplicity, when this guide refers to a manager, it may be taken to mean 
manager or owner. 

• ImageNow or WebNow Client User. This user completes form fields, adds forms as documents, 
views completed forms, or associates forms to existing documents. To add a form to ImageNow, the 
user creates a new document with the form document type or folder type and completes the form 



 

ImageNow eForms Gettings Started Guide Page 9 of 45 

fields. To associate a form to an existing document or folder, the user opens a document in the 
Viewer, and selects a form from the list in the Forms pane. 

• Online User. This user accesses a form from a web site using an embedded URL and enters 
information in the form fields. When this user saves the form, the system sends the form to 
ImageNow or WebNow where an ImageNow or WebNow client user can access the form data. 

Bas ic  Procedures  fo r  ImageNow or  WebNow  
This section explains how to perform basic steps associated with forms. In addition, you will learn how 
to complete, save, print, and delete information in the form fields. These steps are relevant for all types 
of forms that are published in WebNow or ImageNow. 

Note  Before you can view a form, a manager or owner must have granted you the Forms View privilege,  
access to the drawer, and document type or folder type privileges. 

View a form as a standalone document 

A form that is displayed as a standalone document appears in the Viewer and is not associated with a 
scanned image or imported file.  

1. On the ImageNow toolbar, click Documents. 

2. In ImageNow Explorer, conduct your search, and then, in the search results grid, open the 
document. 

Note  The configuration of a form determines where a form is displayed. If a form does not appear in 
ImageNow Viewer, you may be attempting to view a form associated with a document. 
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View a form displayed as supplementa l  informat ion for a document 

This form allows you to capture additional data for existing documents or folders. When you open a 
document in the ImageNow Viewer, this type of form appears in the Forms pane. 

1. On the ImageNow toolbar, click Documents. 

2. In ImageNow Explorer, conduct your search, and then, in the search results grid, open the 
document. 

3. If the form does not display, perform one of the following options: 

• To display the Forms pane, in ImageNow Viewer, on the View menu, click Forms. 

• To select a different form, In the Forms pane, in the Select a form list, select the form. 

View a form displayed as a stand-alone on a fo lder 

A form that is displayed as a standalone folder is a form that appears in Folder Viewer.  

1. On the ImageNow toolbar, click Folders. 

2. In ImageNow Explorer, conduct your search, and then, in the search results grid, open the 
document. 

Note  The configuration of a form determines where a form is displayed. If a form does not appear in 
ImageNow Folder Viewer, you may be attempting to view a form associated with a folder. 

View a form displayed as supplementa l  informat ion for a fo lder 

This form allows you to capture additional data for your documents or folders. When you open a 
document in ImageNow Viewer, this type of form appears in the Forms pane. 

1. On the ImageNow toolbar, click Folders. 

2. In ImageNow Explorer, conduct your search, and then, in the search results grid, open the 
document. 

3. If the form does not display, perform one of the following options: 

• To display the Forms pane, in ImageNow Folder Viewer, on the View menu, click Forms. 

• To select a different form, In the Forms pane, in the Select a form list, select the form. 

What users can do with forms 

After a manager or owner creates a form template, the ImageNow or WebNow user can enter 
information in form fields and save the data, print the forms, or delete form data. 
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To complete a form 

1. View the form 

2. Type your data into the fields on the form. 

3. On the File menu, click Save. Note that closing ImageNow Viewer or ImageNow Folder Viewer also 
saves your changes. 
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To print a form 

1. View the form.    

2. Click the Print Form button. 

3. In the Print dialog box, click Print. 

To save form data 

1. View the form.  

2. Modify information in the fields of a form. 

3. On the File menu, click Save. 

Note  Closing ImageNow Viewer or ImageNow Folder Viewer also saves your changes. 

To delete form data 

Note  After you click Save or close the Viewer in this procedure, your form data is deleted from 
ImageNow Server. There is no undo feature to restore your data. 

1. View the form.  

2. On the Forms toolbar, click the Clear Form Data button. 

3. In the confirmation dialog box, click Yes to save your changes. 

4. On the File menu, click Save. 

Note  Closing the ImageNow Viewer or ImageNow Folder Viewer also saves your changes. 

ImageNow Form Des igner  
In this section, a manager or owner will learn how to use Form Designer to create a customized form 
design that can contain images, links, customized headings and fonts, and so on. You will learn how to 
save and retrieve designs for later use. Additionally, this section explains how to publish form designs 
based on the published location. 

What is ImageNow Form Designer? 

ImageNow Form Designer gives you the ability to create, preview, and publish forms. Form Designer 
allows you to customize elements of a form (such as images, links, and section titles) without the need 
for scripting or technical development. 
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To add fields to a form, Form Designer allows you to select custom properties that a manager created in 
Management Console. Creating fields from custom properties optionally allows the system to complete 
custom properties using the data a user enters in the form fields. This synchronization makes the form 
field data searchable. 

The Form Designer window is divided into four functional areas: 

• Properties pane. View the custom properties that you can utilize to create fields on a form. Custom 
properties are organized by type. You can enter text in the Filter field to quickly find a custom 
property. 

• Toolbox pane. You can drag and drop tools from this pane to add elements to your form such as 
links, columns, and images. 

• Design tab in the center of the screen. This tab is the work area where you construct the form. The 
tab label varies based on the name of a saved form design or a system default name for an unsaved 
form design. If you are working on multiple forms simultaneously, multiple tabs are shown in this 
work area. 
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• Property Attributes pane. This pane allows you to specify information for each form field or 
composite set. This pane enables you to customize the appearance of each form field, define the 
movement of data between the ImageNow Server and the form, and reorder composite properties.  

Custom Propert ies in the Propert ies pane 

The Properties pane in Form Designer organizes the custom properties created in Management Console 
by type. The custom property type affects the behavior of fields in the form. You can use the following 
types of custom properties to create different types of fields in a form: 

• Composite. A composite property type can contain a set of custom properties. This property type 
allows a user to enter multiple values for each property in the set. 

• Date. The accepted number format that a user can enter when completing date fields is based on 
the settings chosen when creating the custom property. 

• Flag. When you add this custom property type to a form, the field appears as a drop-down select of 
two values. The system can automatically display either a selected or a cleared check box based on 
the settings defined for the custom property. 

• List. When you add this custom property type to a form, a list box is displayed on the published 
form. On the form, the user can select one value from the existing custom property. 

• Number. Number fields allow both positive and negative numbers. The accepted number format 
that a user can enter when completing number fields is based on the settings chosen when creating 
the custom property. 

• String. The text fields support all printable ASCII characters within the character set. These fields 
have a character limit of 128 characters. 

• User. When you add this custom property type to a form, the field appears as a list in the form.   
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Create a form design 

You use Form Designer to create a form design. You create a form design by adding elements such as 
custom properties, links, pictures, and more. Using Form Designer, you can save a form design to the 
ImageNow Server or you can publish the form design to ImageNow or to a website. This section explains 
how to add elements in order to create a unique form design.  

Open a Design tab 

To create a new form design, you must open a Design tab. 

• In Form Designer, on the File toolbar, click the New  button. 

Add a field to a form 

A field appears as a blank box on the form and is a space where a user can enter information. You can 
choose whether the fields you add to a form require the user to enter data in order to successfully save 
a form. 

 

To add a field 

Note  You can use each field on a form one time only. 

1. Click and drag a custom property from the Properties pane to an open Design tab in the center of 
the screen. 

2. Optional. To choose the configuration of the rows for a composite property, right-click and drag a 
composite property from the Properties pane to the Form tab: 

• To display each property on individual rows, click Singular. 

• To display the properties as multiple fields on one row, click Repeating. 

To make fields required 

A user must complete all required fields before successfully submitting a form. 

Note  Required fields are enforced only by forms published to Forms Server. 

1. In an open Design tab in the center of the screen, select a field or a composite set. 

2. In the Property Attributes pane, in the Required Fields list, select one or more field name check 
boxes. 
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Reorder composite properties 

Composite properties are groups of custom properties that are created in Management Console. When 
you add a composite property to a form, each included custom property is a field in the form design. The 
composite property appears in the order that it is created in Management Console. Complete the 
following steps to reorganize the order of the fields in a composite property:  

1. Add a composite field to an open Design tab in the center of the screen. 

2. In the tab in the center of the screen, select the composite property. 

3. In the Attributes pane, select the Set Order row and click the ellipsis button. 

4. In the Set Order dialog box, select a property and click Move Up or Move Down to change the order 
of the property, as needed. 

5. Click OK. 

Add sections to a form 

You can create forms with sections that separate areas of a form, such as a customer data section and 
an invoice section. To divide your fields into columns, you can create a section with two columns. 

To create a customized form section 

1. Drag Section from the Toolbox pane to an open Design tab in the center of the screen. 

2. Select and delete the default text, and then enter new text to describe the section. 

3. Drag a custom property from the Properties pane to the new section. 

To create a section with two columns 

1. Drag Two Column Section from the Toolbox pane to an open Design tab in the center of the screen. 

2. Optional. In the Property Attributes pane, do the following: 

• To evenly distribute the width of both columns, select the Balance Column check box. 

• To size the column according to the content size, clear the Balance Column check box. 

Add a picture to a form 

1. Drag Picture from the Toolbox pane to an open Design tab in the center of the screen. 

2. In the Picture dialog box, select the picture and click Open. 

Add a link to a form 

1. Drag Link from the Toolbox pane to an open Design tab in the center of the screen. 
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2. In the Hyperlink dialog box, select a prefix in the Type list. 

3. In the URL field, enter the address. 

4. Click OK. 

Add text to a form 

1. Click in a blank section of an open Design tab in the center of the screen. 

2. Type the text you want to display.  

3. Optional. To change the font, do the following actions: 

• Highlight the text. On the Edit toolbar, click the Font button. 

• In the Font dialog box, change the appearance of the text, including color, style, and size as 
needed. 
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To copy text from another application 

1. Copy the appropriate text from the third-party application. 

2. Place your cursor in a blank section of the open Design tab in the center of the screen. 

3. In Form Designer, on the Edit toolbar, click the Paste  button. 

Change the formatting of a form 

You can customize the font style, size, and color of the text you type in a form, or you can select a 
different style that updates the colors and fonts for all of the elements in a form design. 

To select the font for text 

1. In the open Design tab in the center of the screen, ensure you do not have a field or composite set 
selected. 

2. On the Edit toolbar, click the Font   button. 

3. In the Font dialog box, select the font type, style, size, and color. 

4. Click OK. 

To select a style 

• On the Edit toolbar, select an option in the Style list box. 

To add a background to a property 

1. In the open Design tab in the center of the screen, select a field or composite set. 

2. In the Property Attributes pane, select one of the following options: 

• Optional. Under Background, in the Color field, select a color. 

• Optional. To select an image, complete the following steps: 

1. Under Background, in the Image field, select Open Image. 

2. In the Picture dialog box, select a picture. 

3. Optional. Under Background, in the Tile field, select a repeating pattern for the image. 

4. Click Open. 

To modify a border around a field or composite set 

1. In the open Design tab in the center of the screen, select a field or a composite set. 

2. In the Property Attributes pane, complete any of the following options: 
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• Optional. Under Border, in the Color field, select a color. 

• Optional. Under Border, in the Style field, select a style. 

• Optional. Under Border, in the Width field, enter a positive number to represent the thickness 
of the border in pixels. 
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Working with existing forms 

When you create a design in Form Designer, you can save the design, retrieve it, and then modify it at a 
later time. If you publish the form, you can open the saved design and modify it to publish another form. 

To save a form design 

1. On the File toolbar, click the Save  button. 

2. In the Save Design dialog box, in the Name field, enter a file name and an optional description. 

3. Click OK. 

Note  A user with access to Form Designer can open any saved form design. 

To copy a saved form design 

1. On the File toolbar, click the Open button. 

2. In the Open Design dialog box, select the form and click Open. 

3. On the File toolbar, click the New   button. 

4. Copy the previously saved form: 

• Click the tab in the center of the screen. 

• Select any elements you want to copy. 

• On the Edit toolbar, click the Copy  button. 

5. Paste to the new form: 

• In the Form tab, click the tab. 

• On the Edit toolbar, click the Paste  button. 

To preview a form 

1. Open a form in the tab in the center of the screen. 

2. On the File toolbar, click the Form Preview  button. 

To open a saved form design 

1. In Form Designer, on the File toolbar, click the Open  button. 

2. In the Open Design dialog box, select the name of your saved form design. 

3. Click Open. 
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To export form files 

1. Open a saved form design.  

2. On the File toolbar, click the Export  button. 

3. In the Browse For Folder dialog box, select a folder destination for the files. 

4. Click OK. 

Note  You cannot export the individual form files to your computer after a form is published . 

What is data synchronizat ion? 

You can choose how to synchronize information between the form fields on the form design and the 
custom properties in ImageNow. You can configure the synchronization separately for each custom 
property added to your form. For composite properties, you synchronize composite properties fields as 
a group. To synchronize the data, you must be the owner, a manager, or a user with the Forms Manage 
privilege. 

You can set the system to automatically update the associated custom property in ImageNow based on 
the information a user enters in the form field. This allows the system to index any information a user 
enters in form fields. When you set this automatic update, if any custom property information is entered 
in ImageNow, the form information overwrites it. You can also remove the synchronization so that the 
system does not update custom properties in ImageNow Server based on the information a user enters 
in the form fields. This setting maintains the current custom property set in ImageNow regardless of the 
form field data. 

To synchronize data 

1. Select a property in the tab in the center of the screen. 

2. In the Property Attributes pane, in the Synchronize Data list, select Enabled or Disabled. 

About formatt ing in f ie lds 

When you enable synchronization between the form fields and the custom properties in ImageNow, the 
system automatically verifies the required formatting. If a user enters an unaccepted value and selects 
another field, the system automatically clears the field. If the user enters an accepted value in the field 
and the format is incorrect, the system automatically updates the information to reflect the correct 
format. For example, if a user enters a letter in a field that accepts only numbers, the system clears the 
field of the value. However, if the correct numerical format includes a decimal, after the user enters a 
number without a decimal in a field, the system automatically adds a decimal value of .00. 
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Verify formatting in fields 

When you disable data synchronization, you can choose to verify or disregard the format of the 
information a user enters in a field. When you enable data synchronization, the system automatically 
verifies formatting. 

1. In the Design tab in the center of the screen, select a field. 

2. In the Property Attributes pane, in the Synchronize Data field, select Disabled. 

3. Do one of the following actions: 

• To verify the formatting of the information a user enters in a field, in the Use Format list, select 
the check box for the field. 

• To disregard the formatting of the information a user enters in a field, in the Use Format list, 
deselect the check box for the field. 
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Publ ish forms in Form Designer 

To publish a form in Form Designer, a publishing wizard guides you through each step of publication. 
You can select several options based on the publishing location and type of form. Based on your initial 
selections, the publishing wizard varies the information you are required to complete. For example, if 
you choose to use Forms Server to publish a document type form online, the publishing wizard requires 
you to enter a document type name, select a drawer, and enter at least one document key. 
Alternatively, if you select to publish a document type form only in ImageNow, the only required 
information is a document type name.   

Note  You cannot modify a form after you complete the publication process. However, prior to 
publishing, you can save a form design in order to modify and publish the design at a later time. 

Publish a form in ImageNow 

This type of form is published in ImageNow. Depending on their privileges, ImageNow users can create 
new instances of the form, modify and save form data, and complete associated tasks. 

To publish a form as a document in ImageNow 

1. To open the publishing wizard, on the File toolbar, click the Publish  button.  

2. In the Published Location page, select ImageNow and click Next. 

3. To create the document type, in the New Item page, complete the following options: 

1. In the Type field, select Document. 

2. In the Name field, type the name of the new document. 

3. Optional. In the Description field, type a description. 

4. Click Finish. 

To publish a form on a folder in ImageNow 

1. On the File toolbar, click the Publish  button. 

2. In the Published Location page, select ImageNow and click Next. 

3. To create the folder type, in the New Item page, complete the following options: 

1. In the Type field, select Folder. 

2. In the Name field, type the name of the new folder type. 

3. Optional. In the Description field, type a description. 

4. Click Finish. 
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Publish a form to Forms Server 

When you publish this type of form, you can embed a link on a website that opens the form. Users with 
access to the URL can open the form, enter information in form fields, and submit the form to 
ImageNow. Depending on privileges, ImageNow users can then view the form and complete associated 
tasks in ImageNow. 

To publish a form as a document to Forms Server 

1. To open the publishing wizard, on the File toolbar, click the Publish  button. 

2. In the Published Location page, select Forms Server and ImageNow, and click Next. 

3. To create the document type, in the New Item page, complete the following options: 

1. In the Type field, select Document. 

2. In the Name field, type the name of the new document. 

3. Optional. In the Description field, type a description. 

4. Optional. In the Queue field, select a queue. 

5. Optional. Select or clear the Allow attachments to submitted forms check box. 

Note  Attachments appear as additional pages in ImageNow. 

6. Click Next. 

4. To populate document keys when submitting a form from an embedded URL, in the Document Keys 
page, complete the following options: 

1. Select from the following options in the Source column and enter the appropriate 
corresponding information in the Details column. Then, click Next. 

Source Column Available Selections Corresponding Details Column 

System drawer. Associates a drawer created in Management 
Console to the Drawer document key. 

Select a system drawer. 

Literal. Uses static text. Type static text. 

Unique ID. Generates a Unique ID number. No information necessary. 

Form field. Uses a field included on the form. Select a field. 

Sequence number. Assigns numbers based on a defined 
sequential order. 

Select a predefined sequence or 
create a sequence. 

Timestamp. Assigns the time and date when the user submits 
the form.  

No information necessary. 

Notes   
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• You must select a drawer and at least one document key for forms that a user will submit 
from an embedded URL. 

• To view the drop-down list in the column rows, click in the row. 

5. Optional. To map URL parameters to form elements, in the Publish URL Parameters page, complete 
the following options: 

1. Click Add. 

2. In the Name column, enter parameters that you want to map to form elements. 

3. In the Form field column, select the field in the form. 

4. Optional. Click Add to add rows and URL parameters. 

5. Click Finish. 

Publish a form on a folder to Forms Server 

This type of form is embedded using a URL so that a user can access the form on a web application 
server as well as on the ImageNow Folder Viewer, WebNow Folder Viewer, or the Forms pane. To 
perform this procedure, you must be the owner, a manager, or a user with the Forms Manage privilege. 

1. On the File toolbar, click the Publish  button. 

2. In the Published Location page, select Forms Server and ImageNow. 

3. To create the folder type, in the New Item page, complete the following options: 

1. In the Type field, select Folder. 

2. In the Name field, type the name of the new folder type. 

3. Optional. In the Description field, type a description. 

4. In the Queue field, select a queue. 

4. Click Next. 

5. To populate the folder name when a user submits a form from an embedded URL, in the Folder 
Name page, complete the following options: 

1. Select from the following options in the Source column and enter the appropriate 
corresponding information in the Details column. Then, click Next. 

Source  Details  

Literal. Uses static text. Type static text. 

Unique ID. Generates a Unique ID number. No information necessary. 
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Source  Details  

Form field. Uses a field included on the form. Select a field. 

Sequence number. Assigns numbers based on a defined 
sequential order. 

Select a predefined sequence or create a 
sequence. 

Timestamp. Assigns the time and date when the user 
submits the form.  

No information necessary. 

Notes   

• You must populate the folder name when submitting a form from an embedded 
URL. 

• To view the drop-down list in the column rows, click in the row. 

6. Optional. To map URL parameters to form elements, in the Publish URL Parameters page, complete 
the following options: 

1. Click Add. 

2. In the Name column, enter parameters to map to form elements. 

3. In the Form field column, select the field in the form. 

4. Optional. Click Add to add rows and add additional URL parameters. 

5. Click Finish. 

Note  When you publish a form, you must choose a unique form name. You cannot replace an 
existing form name. 

Admin is ter ing Forms 
This section describes the basic procedures to complete the administration for implementing forms, 
including the following topics: 

• Implementation Process. Provides the high-level steps required to successfully deploy forms. 

• Common administrative tasks. Describes common tasks that a manager or owner in ImageNow can 
complete in Management Console. 

• Assigning Privileges. Details what privileges an owner or manager in ImageNow must grant a user or 
group in order to view or perform tasks for forms.  

• Manual Deployment. Explains manually uploading form components to publish a form.  You may 
find it necessary to manually deploy forms when you upgrade existing forms to a newer version of 
ImageNow or make advanced modifications to form files created in Form Designer. 
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• Manually Modify Form Components. Explains the procedure for manually modifying form 
components and general form information. 

Implementat ion Process 

The following topics provide the high-level steps required to successfully deploy forms. The tasks that 
you must complete vary based on the publishing location. If you are publishing to the Forms Server 
(giving users access to the form online), the required publishing steps are different from publishing to 
ImageNow only. 

Implementing forms in ImageNow only 

The following steps outline the high-level procedures that you need to perform to deploy forms in 
ImageNow. 

1. Install the Forms license. If you need a Forms license, contact your Perceptive Software 
representative. 

2. Create the form files using Form Designer. For more information, refer to “ImageNow Form 
Designer” section in this guide. 

3. Publish the form using Form Designer. For more information, refer to “Publish forms in Form 
Designer” in this document. 
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4. Select from the following form privileges for users or groups: 

• To view the form and its data, grant the View privilege.  

• To modify the data for that form, grant the Modify privilege. 

• To enter data into that form, grant the Create privilege. 

• To clear all form data, grant the Delete privilege. 

For more information, refer to “Administering Forms” in this document. 

5. To access the form, grant a user or group access to the folder type or document type. For more 
information, refer to Administrator Help. 

6. Optional. Associate the form to the workflow queue where the imagenowforms.xml file is 
configured to route the forms. To learn more about routes, refer to Workflow Designer Help. 

Note  Instead of using Form Designer, you can use external editing tools to manually create and publish 
form files. For more information on manually deploying forms, refer to “About manual deployment” in 
this document. 

Implementing forms on a website and in ImageNow 

The following steps outline the high-level procedures that you need to perform to deploy forms 
embedded with a URL in ImageNow Forms Server. 

1. Install the Forms license and restart ImageNow Server.  

Note The system automatically creates the ImageNow Forms group and gives the group access to 
view and submit a form embedded with a URL.  

2. Install and configure the ImageNow Forms Server and Forms Viewer applet. For more information, 
refer to the ImageNow Forms Server Installation Guide, which is available on the Customer Portal. 

3. Create the form files using Form Designer. For more information, refer to the “ImageNow Form 
Designer” section of this guide. 

4. Publish the form using Form Designer. For more information, refer to the “Publish forms in Form 
Designer” section of this guide. 

5. Grant any of the following form privileges to ImageNow or WebNow users or groups. Note that the 
ImageNow Forms group is capable of viewing and submitting forms from an embedded URL 
regardless of the following privileges:  

• To view the form and its data, grant the View privilege.  

• To modify the data for that form, grant the Modify privilege. 

• To enter data in an initial instance of that form, grant the Create privilege. 
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• To clear all form data, grant the Delete privilege. 

For more information, refer to the “Administering Forms” section of this guide.  

6. To access the form in ImageNow or WebNow, grant a user or group access to the folder type or 
document type. For more information, refer to Administrator Help. 

7. Optional. Associate the form to the workflow queue where the Forms Viewer applet is configured to 
route the forms. To learn more about routes, refer to Workflow Designer Help. 

8. Embed the forms URL in your portal or business application. For more information, refer to the 
ImageNow Forms Server Installation Guide available on the Customer Portal. 

Note  Instead of using Form Designer, you can use external editing tools to manually create and publish 
form files. For more information, refer to the “Advanced Form Functionality for Developers” section of 
this guide.  

Common administ rat ive tasks 

The tasks in this section are common tasks that a manager or owner in ImageNow can complete in the 
Management Console. 

Delete a form  

You can only delete forms that have no associated data and are not associated to a conversion queue in 
workflow. You can make a form that has associated data inactive.  

1. In the Management Console, in the left pane, click Forms. 

2. In right pane, on the Forms tab, select a form and then click Delete. 

3. In the confirmation dialog, click Yes. 

To make a form inactive 

1. In right pane, on the Forms tab, select a form and then click Delete. 

2. In the Delete Form dialog box, click Yes to Mark Form as inactive and retain existing form data and 
then click OK. 

Display or hide an inactive form  

You cannot delete a form template that has existing instances; however, you can mark the form inactive 
and remove the form from the list. After you have made forms inactive, you can hide or view inactive 
forms. 

1. In the Management Console, in the left pane, click Forms. 
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2. In the right pane, on the Forms tab, select the Show inactive forms check box to display inactive 
forms or clear the check box to hide inactive forms in this list. 

Associate a form with a workflow queue  

1. In Management Console, in the left pane, click Workflow. 

2. On the Workflow tab, select a process and then click Modify. 

3. In the Workflow Designer dialog box, select a queue and then press ENTER. 

4. In the Queue Properties dialog box, in the left pane, click Forms. 

5. Perform any of the following associations: 

• To attach forms to this queue, click Add, in the Select Forms dialog box, select the forms you 
want to add, and then click OK. 

• To remove a form from this queue, select the form in the list and then click Remove. 

• To change the default form associated with this queue, select the form in the list and click Set as 
Default. 

6. Repeat the previous step for any additional queues. 

7. When you are done associating forms, click OK. 

Assigning Pr iv i leges 

An owner or manager in ImageNow must grant a user or group the appropriate privileges in order to 
view or perform tasks for forms.  

Assign Manage Forms privilege  

This privilege is required to deploy and maintain ImageNow Forms. 

1. To assign a user to manage forms, perform the following steps: 

1. In the Management Console, in the left pane, click Users. 

2. In the right pane, click the Security tab. 

3. On the Security tab, perform one of the following actions: 

• In the Select a user list, select a user and click Modify. 

• In the Search for users box, type all or some of a user name, first or last name and then click 
Search. In the Select a user list, select a user and then click Modify. 
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Note  To sort the Select a user list in ascending or descending order, click the Name, Last 
Name, First Name, or Status column headers. 

4. In the Security Settings dialog box, in the left pane, click Global Privileges. 

5. In the Privileges list, under Manage, click the column to the left of the Forms privilege so that 
 is displayed to grant the privilege. 

2. To assign a group to manage forms, perform the following steps: 

1. In the Management Console, in the left pane, click Groups. 

2. In the right pane, click the Security tab. 

3. On the Security tab, perform one of the following actions: 

• In the Select a group list, select a group and click Modify. 

• In the Search for groups box, type all or some of a group name, and then click Search. In the 
Select a group list, select a group and then click Modify. 

Note  To sort the Select a group list in ascending or descending order, click the Name or 
Description column headers. 

3. In the Security Settings dialog box, in the left pane, click Global Privileges. 

4. In the Privileges list, under Manage, click the column to the left of the Forms privilege so that  is 
displayed to grant the privilege. 

Set privileges for a form  

1. On the ImageNow toolbar, click Manage. 

2. In the Management Console, in the left pane, click Forms. 

3. In the right pane, in the Form list, select the form you want and then click Modify. 

4. In the Form dialog box, in the left pane, click Security. 

5. In the right pane, in the Select a presentation box, select a presentation. 

6. Under Users/Groups, click Add. 

7. In the Select Users and Groups dialog box, perform one or both of the following options: 

• On the Users tab, to assign a user form privileges, perform one of the following: 

• In the Search results list, select one or more users, click Add and then click OK. 

• In the Search for users box, type all or some of a user name, first or last name and then click 
Search. In the Search results list, select one or more users, click Add and then click OK. 
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Note  To sort the Search results list in ascending or descending order, click the User Name, Last 
Name, or First Name column headers. 

• On the Groups tab, to assign a group form privileges, perform one of the following: 

• In the Search results list, select one or more groups, click Add and then click OK. 

• In the Search for groups box, type all or some of a group name and then click Search. In the 
Search results list, select one or more groups, click Add and then click OK. 

Note  To sort the Search results list in ascending or descending order, click the 
Group Name column header. 

8. In the Form dialog box, under Users/Groups, select the user or group you want to grant privileges 
to. 

9. In the Privileges list, click the column to the left of the Forms privilege so that is displayed for the 
following privileges as needed: 

• To view the form and its data, grant the View privilege. The View privilege is required to make 
the other privileges effective. 

• To modify the data for that form, grant the Modify privilege. 

• To enter data into that form, grant the Create privilege. 

• To delete data in that form, grant the Delete privilege. 

• Repeat these steps for each user and group who needs access to the form. 

About manual deployment 

If you choose not to use Form Designer to publish a form, you can manually upload form components to 
publish a form.  You may find it necessary to manually deploy forms when you upgrade existing forms to 
a newer version of ImageNow or make advanced modifications to form files created in Form Designer. 

The following files are used in forms in ImageNow, although you can optionally use CSS, graphics, and 
JavaScript. 

• Presentation Template This XSL file describes how to present the XML data in the form.  

• Data Definition This XML file contains the schema used to save data instances in data content 
record files.  
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• Data Content Record  This XML file contains individual instances of form data based on a 
corresponding data definition file.  

Note  For more information on using external tools to create forms, refer to Enhanced Forms Help, 
which is available in the Product Documentation tab on the Customer Portal area of the Perceptive 
Software website. 

Manually load form components and create a form in ImageNow 

Form Designer automatically creates and uploads the form components in ImageNow. You can export 
those files or create your own components to upload into ImageNow. This section gives instruction on 
manually loading the required form components successfully in ImageNow. 

To upload the XML data definition file 

1. On the ImageNow toolbar, click Manage. 

2. In the Management Console, in the left pane, click Forms. 

3. In the right pane, click Manage Components. 

4. On the Manage Form Components dialog box, in the Data Definitions pane, click Add. 

5. In the File Open dialog box, navigate to the folder where your local form files are stored, select the 
XML file you created for this form, and then click Open. 

6. Optional. Upload files to share with more than one presentation: 

1. In the Shared Files pane, click Add. 

2. In the Shared Files dialog box, select the optional files you created that you want to share with 
more than one presentation and then click Open. 

To upload XSL files, supporting files, and organize your files into presentations 

1. On the Presentations pane, click Create, type a name for your presentation, and then press ENTER. 

2. Select the presentation you just created and click Modify. 

3. Optional. In the Presentation dialog box, in the General pane, type a description for your 
presentation. 

4. In the Files pane, click Add, select the XSL file and any optional files you created for this 
presentation and then click Open. 

5. If you previously added shared files that you want to use in this presentation, click Select Shared 
Files, in the Select Shared Files dialog box, select the files you want and then click OK. 

6. If you created more than one XSL file to use with your XML file, repeat these steps for each XSL file. 
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7. Click OK. 

To create your form from your data definition file and presentations 

1. On the ImageNow toolbar, click Manage. 

2. In the Management Console, in the left pane, click Forms. 

3. In the right pane, on the Forms tab, click New. 

4. Type a unique name for your form and then press ENTER. 

5. Select the form you just created and click Modify. 

6. Optional. In the Form dialog box, in the General pane, in the Description box, type a description for 
your form. 

7. In the Components pane, under Data Definition, in the Data definition list box, select the XML file 
you created for this form. 

8. Click Select to choose presentations you want to be available for use with this form, in the Select 
Presentations dialog box select the presentations and then click OK. 

9. Click OK. 

To set user or group privileges for your form 

1. On the ImageNow toolbar, click Manage. 

2. In the Management Console, in the left pane, click Forms. 

3. In the right pane, in the Form list, select the form you want and then click Modify. 

4. In the Form dialog box, in the left pane, click Security. 

5. In the right pane, in the Select a presentation box, select a presentation. 

6. Under Users/Groups, click Add. 

7. In the Select Users and Groups dialog box, perform the following: 

• On the Users tab, to assign a user form privileges, perform one of the following: 

1. In the Search results list, select one or more users, click Add and then click OK. 

2. In the Search for users box, type all or some of a user name, first or last name and then click 
Search. In the Search results list, select one or more users, click Add and then click OK. 

Note  To sort the Search results list in ascending or descending order, click the User Name, 
Last Name, or First Name column headers. 

• On the Groups tab, to assign a group form privileges, perform one of the following: 
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1. In the Search results list, select one or more groups, click Add and then click OK. 

2. In the Search for groups box, type all or some of a group name and then click Search. In the 
Search results list, select one or more groups, click Add and then click OK. 

Note  To sort the Search results list in ascending or descending order, click the Group Name 
column header. 

8. In the Form dialog box, under Users/Groups, select the user or group you want to grant privileges 
to. 

9. In the Privileges list, click the column to the left of the Forms privilege so that  is displayed for the 
following privileges as needed: 

• To view the form and its data, grant the View privilege. The View privilege is required to make 
the other privileges effective. 

• To modify the data for that form, grant the Modify privilege. 

• To enter data into that form, grant the Create privilege. 

• To delete data in that form, grant the Delete privilege. 

10. Repeat this procedure for each user and group who needs access to the form. 

Optional. To associate the form with a workflow queue 

1. On the ImageNow toolbar, click the Manage down arrow and then click Workflow. 

2. On the Workflow tab, select a process and then click Modify. 

3. In the Workflow Designer dialog box, double-click the queue. 

4. In the Queue Properties dialog box, in the left pane, click Forms. 

5. Click Add, in the Add Form dialog box, select the forms you want to add, and then click OK. 

6. When you are done associating forms, click OK and then click Close. 

Manual ly  Modify  Form Components 

Once a form has been loaded in ImageNow, you can modify form components manually. The following 
steps explain the procedures to manually modify and replace form components and general form 
information. 

To manually modify general form information 

1. On the ImageNow toolbar, click Manage. 

2. In the Management Console, in the left pane, click Forms. 
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3. In the right pane, select a form and then click Modify. 

4. In the Form dialog box, you can make the following changes to your form: 

• In the General pane, you can modify the form name, description, and set the form to active or 
inactive. 

• In the Components pane, you can change the data definition file to use with this form and which 
presentations are available for this form. 

• In the Security pane, you can grant or deny form privileges to users and groups. When you are 
done modifying the form, click OK. 

To manually replace a data definition file  

1. In the Management Console, in the left pane, click Forms. 

2. In the right pane, on the Forms tab, click Manage Form Components. 

3. In the left pane, select Data Definitions.  

4. Select the existing data definition in the forms list and then click Replace. 

5. In the Replace confirmation dialog box, click Yes. 

6. Navigate to the XML file you wish to use to replace the existing one and then click Open. 

Warning  Replacing your data definition file can cause existing XML instances to become corrupted. 
This is especially true if you removed or modified an existing element. Adding new elements should 
not corrupt data, but the elements in the existing XML instances will not be populated, so you need 
to populate them. 

7. To remove a data definition file, select the existing data definition in the form list and then click 
Remove. 

Note  Changes to form files do not affect users who are currently logged in until they log out and in 
again. 

To manually replace a shared file 

1. In the Management Console, in the left pane, click Forms. 

2. In the right pane, on the Forms tab, click Manage Form Components. 

3. In the left pane, select Shared Files. 

4. To replace an optional file, select the existing file in the list and then click Replace. 

5. In the Replace confirmation dialog box, click Yes. 

6. Navigate to the file you wish to use to replace the existing one and then click Open. 
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To manually remove a shared file 

1. In the Management Console, in the left pane, click Forms. 

2. In the right pane, on the Forms tab, click Manage Form Components. 

3. In the left pane, select Shared Files. 

4. To replace an optional file, select the existing file in the list and then click Remove. 

Note  Changes to form files do not affect users who are currently logged in until they log out and in 
again. 

To manually replace a presentation 

1. In the Management Console, in the left pane, click Forms. 

2. In the right pane, on the Forms tab, click Manage Form Components. 

3. In the left pane, select Presentations. 

4. To modify a presentation, select the presentation in the list and click Modify. 

• In the General pane, you can change the presentation name and description. 

• In the Files pane, to add files to an existing presentation, click Add, navigate to the file and then 
click Open. 

• To add shared files on the ImageNow Server to the presentation, click Select Shared Files, select 
the files and then click OK. 

• To replace a file, select the file in the list, click Replace, navigate to the new file and then 
click Open. 

• To remove a file, select the file in the list and then click Remove. 

• In the Presentation dialog box, when you are finished making changes, click OK. 

• To remove a presentation, select the presentation in the list and click Remove. 

Note  Changes to form files do not affect users who are currently logged in until they log out and in 
again. 

5. When you are finished modifying components, click OK. 
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To manually add a form to a document type  

Use the following procedure to select a form to associate with a document displayed in ImageNow 
Viewer or WebNow Viewer. 

1. In the Management Console, in the left pane, click Document Types. 

2. Select a document type and then click Modify. 

3. In the Document Type dialog box, in the General tab, check the Is a form check box and then select 
a form in the Form list. 

4. Click OK. 

To manually add a form to a folder type  

Use the following procedure to select a form to associate with a folder displayed in Folder Viewer. 

1. In the Management Console, in the left pane, click Folder Types. 

2. Select a folder type name and then click Modify. 

3. In the Folder Type dialog box, in the General tab, check the Is a form check box and then select a 
form in the Form list. 

4. Click OK. 

5. Whenever you create a new folder based on this folder type, you must add it to a workflow queue. 
Otherwise, the folder cannot be accessed by the user of the folder. 

To add shared form files  

1. In the Management Console, in the left pane, click Forms. 

2. In the right pane, click Manage Components. 

3. In the Manage Form Components dialog box, in the left pane, click Shared Files. 

4. Click Add. 

5. In the File Open dialog box, navigate to the folder where your local form files are stored, select the 
files you want to add, and then click Open. 

6. Click OK. 

Advanced Form Func t iona l i t y  f o r  Deve lopers  
Using standard HTML, XSL, and XML, you can use external editing tools, such as Microsoft FrontPage or 
Adobe Dreamweaver to extend the functionality of forms that you create using Form Designer. Form 
Designer builds a Presentation Template and one Data Definition file. You can expand this by building 
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multiple Presentation Templates for each Data Definition file. You can provide external Cascading Style 
Sheets (CSS) files or add in-line CSS to the XSL file. In addition, you can use JavaScript files for standard 
numeric functions, data validation functions, or other common functions, such as context-sensitive help. 

To deploy a modified form, you load the form files onto the ImageNow Server. If you are deploying a 
form to use with the ImageNow Forms Server, you associate the form with a folder type or document 
type. If you are deploying a form to use in the Forms pane, you can optionally associate the form with 
any appropriate workflow queues.  

The following files are used in forms in ImageNow, although you can optionally use CSS, graphics, and 
JavaScript: 

Presentation Template  This XSL file describes how to present the XML data in the form. You can use 
many presentations with a single XML source file, so you can create different formatting or views of the 
data for each form you create. Each presentation can have different security settings. Through these 
settings, you can control access to your forms. Additionally, external ODBC access is provided through 
iScript, a scripting language available with ImageNow. 

Data Definition  This XML file contains the schema used to save data instances in data content record 
files. You can also add data to elements in this file to pre-populate fields in your form the first time it is 
displayed to a user. 

Data Content Record  This XML file contains individual instances of form data based on a corresponding 
data definition file. The data captured during form processing is stored for viewing, editing, searching, 
and archiving purposes. ImageNow creates and maintains the data content record files for you based on 
your data definition file. ImageNow stores these records as subobjects. 

Notes  

• If you are using external editing tools to create form files, the system does not support files encoded 
with UTF-8 with BOM. 

• For more information on using external tools to create forms, refer to Enhanced Forms Help, which 
is available in the Product Documentation tab on the Customer Portal area of the Perceptive 
Software website. 

Gett ing started with extending forms 

After you create form files using Form Designer, you can use an external editor to make enhanced 
modifications to the form files. You deploy the extended forms in ImageNow Client. Advanced 
modification of a form requires a basic knowledge of HTML, XML, Cascading Style Sheets, iScript, and 
JavaScript. 

The following steps outline the high-level procedures that you need to perform to use forms in 
ImageNow: 
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1. Install your required Forms license if you have not installed it already. If you need a Forms license, 
contact your Perceptive Software representative. 

2. Ensure that you are an owner or manager, or are assigned the Manage Forms privilege. For more 
information, refer to “Assigning Privileges” in this document. 

3. Create your form files using Form Designer.  For more information, refer to “Create a form design” 
in this document. 

4. Save the form in Form Designer. For more information, refer to “Save a form design” in this 
document. 

5. Export the form files from Form Designer. For more information, refer to “Export form files” in this 
document. 

6. Use external editors to modify the form files. For more information, refer to “Advanced Form 
Functionality for Developers” in this document. 

7. Manually deploy the form. For more information, refer to “About manual deployment” in this 
document. 

8. Set privileges for documents associated with forms and privileges for any workflow queues. For 
more information, refer to Administrator Help. 

9. Optional. Associate the form to the workflow queue where the imagenowforms.xml file is 
configured to route the forms. To learn more about routes, refer to Workflow Designer Help. 

Form design and planning   

The following lists contain areas to consider when designing your form files: 

Specific file design considerations 

• Is it best to use HTML tables inside your Form elements to position your HTML controls? Will you 
need to dynamically add or delete rows to the table? You must use the controls provided in 
ImageNow to add or delete rows in tables. Do you need to dynamically repeat rows or entire 
sections in a form table? These features only work inside HTML tables. We recommend using tables 
to align your HTML controls. 

• Since you can share the optional, supporting files between forms in ImageNow, consider creating 
supporting files in a manner that facilitates the sharing of duplicate formatting and graphics. For 
example, you can share a company logo. 

• Are there repeating HTML controls? Some of this can be handled by the controls provided with 
ImageNow. In other cases, you must write your own code. 

javascript:TextPopup(this)
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• Do you want to provide context-sensitive JavaScript help content for your forms? Basically, this is 
help that describes to the user how to fill out individual form elements or that describes the purpose 
of a particular form. 

• What editing and authoring tools do you want to use for your form files? You can use standard tools, 
such as Microsoft FrontPage or Adobe Dreamweaver. 

• ImageNow does not yet support a full browser environment, so plug-ins such as ActiveX, Java 
applets, and Flash are not currently supported by Perceptive Software Product Support. 

Data validation considerations 

• How much client-side validation do you need on fields during data entry? This type of validation 
requires JavaScript in the XSL file. ImageNow provides some controls for validation, but you may 
have to write your own validation code as well. 

• Do you need to perform validation of data from external data sources? For example, you need to 
enter a Vendor ID in a form and then have that value checked against an external table of valid 
vendor IDs. If the value does not match, the user gets an error message and form data is not 
submitted until the value is valid. 

Business application integration considerations 

• Plan your XML schema according to the mapping your business application requires if you plan to 
integrate data. 

• Do you want to provide ODBC access to your form data? You must add specific ImageNow tags to 
your XML file for ODBC access. 

HTML and XSL form control considerations 

• Do you need any numerical calculations done by your form? 

• Do you need any hidden controls? Hidden controls can temporarily store variables while a form is in 
use. 

• Do want any fields to be pre-populated with values from the XML schema? 

• Do you need conditional control content such as the selection of a radio button dynamically 
dictating the values in a list box? 

Integration with other ImageNow features 

• Are database lookups needed to pre-populate list boxes with data from your existing databases? 

• Do you want any of the entered data to populate document keys or custom properties? You need to 
add specific tags to your XML file to populate these items. 

javascript:TextPopup(this)
javascript:TextPopup(this)
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• Do you want to perform searches on any of the data entered into forms? If so, which fields? You 
must add these fields to custom properties to enable searching in ImageNow. To enable this type of 
search, create the basic form using Form Designer.  

• Do you require the ability to access internal ImageNow data and use that data to populate form 
elements? For example, you can populate a list box with document key values. To enable this data 
exchange, you need to create the basic form using Form Designer. 

About form data binding 

The following list describes how ImageNow forms presentation and data definition files work together 
to store your data: 

• The data definition XML files are only XML fragments. 

• The main presentation file is HTML generated by an XSL stylesheet. 

• The generated XML structure of a presentation file must match the XML data definition structure in 
order for ImageNow to correctly automate the data extraction process. 

• The <xsl:value-of select="/<path>/<to>/<node>"> syntax reference is used to map a display element 
from a presentation XSL file to a data element in the data definition XML file. 

• If you reference any variable or function in the select attribute of the element in the XSL file, 
data binding cannot occur for that element. 

• These custom attributes are available for the supported HTML form controls of INPUT type. 

• repeat 

• delete 

• deleterow 

• newInstanceRows 

• The <xsl:value-of> only works to bind data in the following HTML form controls: 

• INPUT type=button 

• INPUT type=hidden 

• INPUT type =text 

• INPUT type=check 

• INPUT type=radio (But all of these radio buttons must be children of a DIV tag.) 

• TEXTAREA 
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• The relative position or order of nodes is not guaranteed. 

• Repeating elements of a single type must exist under a single parent node for that type. 

• XSLT version 1.0 is fully supported for data binding except for the preceding exceptions. 

The generated form that a user views in ImageNow is an HTML document. Remember this when you are 
creating your data definition and presentation files. When you create your data definition, first consider 
what data you need and how the data is related. After you have these requirements, you can determine 
how to represent this data in the XML data definition that facilitates data mapping and data display. 
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